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Symbols used in this manual Technical Support

Technical Support is provided by

Symbols used in this manual have the following meanings: Leica Geosystems worldwide network
of representatives. We are represented

DANGER in almost every country in the world. A

A Indicates an imminently hazardous situation which, if not avoided will  representative directory is available at:

result in death or serious injury.
www.leica-geosystems.com

WARNING
Indicates a potentially hazardous situation which, if not avoided, could
result in death or serious injury.

CAUTION

A Indicates a potentially hazardous situation which, if not avoided, may
resultin minor or moderate injury and/or appreciable material, finan-
cial and environmental damage. The symbol is also used to alert
against unsafe practices.

@ Important paragraphs which must be adhered to in practice as they
enable the product to be used in a technically correct and efficient
manner.
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Introduction to this book

What is a format file?

The aim of this book is to help users in getting started with using the
Format Manager software to create format files (.frt files) that can be
used with Leica GPS System 500.

The best way to learn how to use the Format Manager is to actually
generate format files. There are 3 "Quick Tours" in this book which
are step by step tutorials explaining how to create the following 3
different format files:

» Quick Tour I -  Report Style format file

» Quick Tour Il - Leica GSI16 output format file using
thematical coding

» Quick Tour Ill - Leica GSI16 output format file using

free coding

It is recommended that you complete all of these Quick
Tours. What you learn in Quick Tour | you will need to
use in Quick Tours Il and Il1.

=

After completing these Quick Tours you should be able to appreciate
the flexibility of format files and be able to create a format file for
almost any output type you need.

For example, it is possible to create both common output formats
such as a Geodimeter type format or a Sokkia SDR33 format and an
unlimited number of unique "report" style formats.

Any surveyed data can be used with these format files. However,
sample data is provided on the SKI-Pro CD which can be used with
each of the Quick Tour format files.

Getting Started with Format Manager-1.1.0en

A format file is quite simply a "mask" or "filter" which allows
surveyed GPS data to be exported in any format as an ASCII text file.
The format file can be used both in SKI-Pro and on the System 500
sensor.

For example one user may wish to export post processed data from
SKI-Pro in a standard Leica GSI16 format. A second user wishes to
export RTK data from the sensor in a "Report Style" format.

Using the appropriate format file, the export of any data from the
sensor and SKI-Pro into both these formats is possible. It is thus
easily possible to build up a library of many different output formats.

Each format file needs only to be created once and the same format
file can be used on both the sensor and with SKI-Pro.

Introduction to this book



What is the Format Manager?

The Format Manager is the software that is used to create the format  If you have not yet installed SKI-Pro on your PC, please refer to the
files. It is automatically installed onto your PC when you install SKI-

Getting Started with SKI-Pro user manual for installation
Pro. You do not require a software protection key (dongle) to use the instructions.
Format Manager.

mmat Manager - [Gsi8_TPS_them.frt]

I = S
ile Wiew Fomat Options Window Help == x|
_|_|E|3| 212 8l(e] 8%
= Q Header 4l«Blocknumber - {GSI)»+«Code-ID»-42....+«Attribute-1»-43....+cAttribute 2»-44....+ad

4 General 1i«Blocknumber' {GSI)»+«Point-ID-(Target)»-51..10«Target-(East)»-52..10«Target - (FNort
Blocks

sport Formatstings
23 Baseline Information [GPS)
& Code (TPS/GPS)
Cp Date/Time Information (GPS)
2z Event Infomation (GFS)
=G Fispoint [TPS/GP)

By Expoitstiing
Zp Job [TPS/GPS)
g Qualiy information [GFS)
23 Satelite Information [GPS)

+ Insert export variables. . E M= =

Datablock Type

Available wariables

o

.+tribute3 45....+tributed

123-98 81..10+40123877 &2..10+23333565 §3..10+01000223
b, Local pos. lat (deg)

s Local pos. lon (deg)

b, WESE4 pos. |atiude (deg)
b, WS84 pos. lon (deg)
Blocknumber [551)

CLASS

TreeOl 4Z....+tributel 43....+tributez 44...
b=, Cornergence angle [deg) iI

Combined scale factar

Convergence andle

Convergence angle (dec. mir)

Convergence angle (deg) Jid|

Insett

For Help, press F1

GPS500_Standard
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Starting and exiting the Format Manager

To start Format Manager: To create a new format file:

»From the Windows™ Start bar, click Programs Upon starting the Format Manager, you can choose to create a new
format file or open an existing format file.
»Select SKI-Pro

> Select F t M »To create a new format file, ensure that GPS500 is chosen as the
elect Format Manager Instrument Class and then click OK.

B Fogans 3 () accessories D i Format file type. ..

& IE sKI-Pro nat
= Documents L Startup » | RoadLine Edtor Instrument class
-? @ S et » Software Yideo Camera b i Satelite Availability 20
= Settings

& SKI-Pro Eormat fils type

Q] End ’ ) UnintllLoca 5K1Pro W
E @ Help
g
| 1 8
=
; Shut Dawn...
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To exit Format Manager:

Firstly ensure any changes you have made to a format file are
saved.

>From the File menu click Exit or click on the Xl icon of the Format
manager main window.

rmat Manager - [Baker. FRT] >
View Format Options  Window Help ==
[ Mew sisll |y
— Dpen... Strg+0 —
= Close «Point-ID- {Target)»-«Code IDs-Attl: - <Attribute - Hame
; Save Strg+5

E| Save as

1 D:\Program Filesh.. \Baker. FRT
2 Annotations. FRT

3 Events FRT
4.)_Orth_Height=.FRT
5._Ell_Heights.FRT

Kl — 3
E Geodemeter 2.FRT _I

! PP123-98 TreeDl Attl: Attribute Nawe 1 Attribute
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An Overview of Format Manager

Format Manager runs on 32-bit Microsoft Windows™ 95,98 or NT
platforms. It is based on standard Windows™ operating procedures
and is therefore very easy to learn and to use

The Format Manager screen is divided into 3 sections - the Tree-
View, the Edit-View and the Format String Preview sections.

The size of each section can be adjusted by clicking and dragging
the Section Separators.

g1 Format Manager - [FM document FRT]
) Fle View Fomat Opfions Window Help

- Menu options

| Dlslms] &= sl 2

-4 Header
-4 Export Formatstings
- Baseline Information (GPS)
-G Code [TPS/GPS]
[#-<Zp DatedTime Information (GPS)
G Event Information (GPS]
B+ Fispoint (TPS/GPS)
‘B [Exportstiing
<2 Job [TPS/GPS)
<2 Qually information [GPS)
< Satellite Information [GPS) —

Toolbar

Tree-View

«Point-ID- {Target)»-«Target - (Bast) »~«Target - (Horth) »-«Target - (Elev)»-«C

The Menu options and Toolbar are used to navigate through the
software.

Edit-View

Section Separators -

Far Help. press F1

| |

5123333.565 1000.223 Tree0l
« | |
GPS500_Standard [CaP [NUM | 7

Format String
Preview

Getting Started with Format Manager-1.1.0en

An Overview of Format Manager



Views

Tree-View:

The tree view provides an overview of all the Header data blocks
and all Export Formatstrings in an expandable hierachy of books
4 and pages [ .

Double click on an item or click to expand it.
If an item is open, double click on it or click [F] to close it.

If a Header data block or an Export Formatstring contains data
then the page is shown thus:

-4 Header
EQ General
[ File Header
- File Footer
BElocks
- Baseline Information [GF5]
[ Code (TPS/GPS)
-[% Date/Time Information [GPS)
[ Event Infarmation (GPS]
- Fixpoint (TPS/GPS)
O Job (TPS/GPS)
[ Quality information (GPS)
[y Satelite Information (GPS)
E-Q Export Foimatstings
&7 Baseline Infarmation (GPS)
& Code [TPS/GPS)
& Date/Time Information [GPS)
<& Event Information [GPS)
1-Zp Fispoint (TPS/GPS)
B g
Qp Joh [TPE/GPS]
#-<Zp Quality information [GPS)
& Satellte Information (GPS]

Tree-View

An Overview of Format Manager

Edit-View:

After selecting a Header data block or an Export Formatstring
from the tree view, the data that should be exported for that Header
data block or an Export Formatstring is entered in the Edit-View.

The Edit-View is basically similar to any text editor. Any text that is
required to be included in the output file needs to be entered here.

In addition, if an Export Formatstring page is selected from the
Tree-View then the Insert export variable dialog box appears.
This allows any variables that are to be exported to be chosen.

+ Insert export variables... [=1-[C1]

Datablack-Type

Available variables

45, Convergence angle [deg) =
abs. Losal pos. lat [deg)
bs. Local pos. lon [deg)
Abs, WESS4 pas. latiude (deg]
Abs. W54 pos. lon deg]
er (GSI)

CLASS

Combined scale factor

Convergence angle

Convergence angle [dec. min]

Convergence angls (deg) =l

Insert

Insert export variable dialog box

Getting Started with Format Manager-1.1.0en



Format String Preview:

The Format String Preview section is simply a preview screen. It
allows you to see how the text and export variables will look
when the format file is used. No data can be entered in this screen.

Example of how the Views may look
hil king in the F M :
Whilst working in the Format Manager In the Edit-View a mix of some text and
export variables has been entered

Format Manager - [Baker.FRT] =] E3

[Z] File ‘iew Fomat Options ‘wWindow Help TS
Do) &' Mltslew| 2 %]
= 0 Header Point-ID: -«Point-ID- (Target)s
& Generl Easting:-«Target (East)s nseit export vanables_ 2] 0]
4 Blocks Northing: -«Target (Horth)s The Insert export
= Q Export Fnrmalstlings. Height: -«Target (Horth):» Datablock-Type Variable dialog bOX
G Baseline Information [GF%) ) "
& Code [TPS/6PS) [Fispait (TP5/5PS) Il is active because an
G DateTime Information (GPS]
G Event Infomation (GFS) (R RS Export Format
. G Fispoint (TPS/GPS) ring i | in
In the Tree-View the — Expartstiing Target [Elev] String is se ected
. . 1 p Job (TPS/GPS] ooty — the Tree-View
Fixpoint Export Format & Qualty informaton (5FS) B I a8 GTES pog, catl %
- - asting: . .
String has been selected & Sotelie Infomaion (PS) Horthing: 123333.585 EeBt o oo
Height: 123333.565 WESE4 pos. lat (dec. min) J
(G584 ns ol [ser]
G504 pins, Iatiude (ds)
'WESE4 pos. |atitude [min] ﬂ
Ingert

Far Help, press F1

|GPS500_Standard [ [NUM 7

In the Format String Preview you can see
how the output data would appear when this
format string is used

Getting Started with Format Manager-1.1.0en
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Quick Tour I - Creating a Report Style Output

This Quick Tour is a step-by-step tutorial to create a format file that
will output data in a "report style" format.

The following output is required:

" [ Company Hame

RTK Survey Report

Footer

Company Address

Header e A
Block Tites 1  Fasting Hor thing Height Code  300Q
. | 2 549006.191 5248400.888 464797 HOUS 0.01
Export Formatstrings — | sH7es  Su9es2_u1e 5248342 759 464 . 021 SH 8.01
TP3086  549211.519 5249188 . 059 4563146 HULL 0.00

End of data

This format file has the following sections:

* Header information appearing only once at the head of the report.

* A Block Title appears once over the actual surveyed data output.

* Export Formatstrings (the surveyed data) arranged in tab
delimited columns.

* Footer information appearing only once at the end of the report.

=

Quick Tour | - Creating a Report Style Output

A format file does not always have to include a
Header, Block Titles or a Footer.

Note also the following characteristics of this format file:
* All the Export Formatstrings are left aligned.

* The Coordinate values are output to 3dp but the CQ values are
output to 2dp.

* There are 2 blank lines between the Header and the Block Titles
and two blank lines between the Export Formatstrings and the
Footer.

* Point TP306 was not coded when it was surveyed. In the output
above, it is given a "default value" of NULL.

Getting Started with Format Manager-1.1.0en



Lesson One - Creating the Header and Footer

In Leson One you will learn how to create the header and footer for
the format file.

Start-up the Format Manager:

»From the Windows™ Start bar, click Programs, SKI-Pro and then
click on Format Manager.

+ Format file type....
The Format file type dialog box
appears.
»Click OK to create a GPS500 new g =
format file.

The main Format Manager window appears.

ForHap, poss 1 GPSB00 Stardrd (I -

Getting Started with Format Manager-1.1.0en

»>In the Tree-View open the Header folder
and then the General folder.

] Format Manager - [Noname1]
[ Fie View Fomat Options W

D|es|ees] 22 &I

=4 Header
= 4 General
[ (e

»Select the File Header page.

[ File Footer
@ Blocks
% Export Fomatstrings

Click in the Edit-View section and enter the text for the first line of the
header.

»Type the words Company Name and then then press Tab on your
keyboard 7 times. Then type the words Company Address and
then press Enter.

[} Format Manager - [Noname1]
fl\e “iew Fomat Options  ‘window Help

SRR
Ry
L [ File Haader
[y File Footer
4 Elocks

-4 Export Formatstings

=

Company * Narg———-—-—Company + Address]

As you enter text in the Edit-View, the same text can be
seen in the Formatstring-Preview section. Remember,
you cannot enter text in this section - it is a preview
screen of what is currently shown in the Edit-View.

A space is shown as a= and a tab is shown as a =1 in
the Edit-View.

=
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»Underline the words Company Name and Company Address using =

to underline the text. Press ENTER after entering the last =.

»Enter the rest of the header text. Enter 4 tabs before the words
RTK Survey Report to centre this text. Press ENTER after the last

»Press ENTER 2 more times. This will put two empty lines before the
text which will follow.

Bif. Format Manager - [Noname]

[Z) Fie View Fomat Options “indow Help

= 4 Header Company - Hee—————— Company - hddress
B4 General
[ File Header
[y File Footer
@ Blocks
4 Expont Fomatstings

Company hddress

You have now completed the header for this format file. We will now
enter the footer details.

Quick Tour | - Creating a Report Style Output

»Select the File Footer page.

[} Format Manager - [Noname1]

E\\e Yiew Format Options  ind

N = S A TN

Note how the File Header
page has become grey to
show that there is data
entered for this page.

=

-4 Export Formatstrings

Click in the Edit-View section and enter the text for the footer.

»Press ENTER twice. This will put two empty lines after the data that
will be output and before the footer text.

»Enter 4 tabs and then type the words End of Data.

B, Format Manager - [Noname1.FRT]

[ File View Fomat Oplions ‘window Help

D|=|mle| &1 Slmls=] 2%
=4 Header
B9 Genetal
File Header
[ File Facter
@ Blocks
4 Ewport Fomatstings

—-mnEnd-of -Data

End of Data

You have completed the footer for this format file. We will now
create the Block Titles.

Getting Started with Format Manager-1.1.0en



Lesson Two - Creating the Block Titles

Lesson Three - Creating the Export Formatstrings output

A Block Title is text that will appear as a
"title" above any surveyed data that will
be output as Export Formatstrings.

Bl Format Manager - [Naname1.FRT]

A Fle View Fomal Options Window Help

M E S

4 Header
B 0 General
>In the Tree-View open the Blocks I g
folder and then select the Fixpoint (TPS/ = Blocks

[ Baseline Information [GFS]
- [4 Code [TPS/GPS]

[ DaterTime Information [GFS)
-0 EventInfomation (GPS)

GPS) page.

O
- [y Job (TPS/GPS)
[ Quality information [GPS)
- [ Satelits Information [GPS]
4 Export Formatstrings

Click in the Edit-View section and enter the text for the block title.

»Enter the text as shown below and then press ENTER. Use the - to
underline the text.

»Press ENTER at the end of the last - . This will ensure the Export
Formatstrings are output on a new line.

p. Format Manage - [Noname1.FRT]
e View Fomat Opfions Window Help

DBEEb i = AL

-4 Header ID-Easting--Northing-Height-—Code~3DCQ
-4 General
=4 Blocks

i3 Baseline Infmation [GPS)
[ Code (TPS/GPS)
) Date/T ime Infomation [GPS]
[GPS)

D Fasting Northing  Height Code  3DCQ

[ Quality information IGPS)
o[y Satelite Information (GPS)
4 Export Formatstrings

=

Note there are two tabs between Easting and
Northing and Height and Code. This is to space the
output data correctly.

Getting Started with Format Manager-1.1.0en

The Export Formatstrings are the actual surveyed data values that
are required to output. For this format file we need to output the
following export variables:

* Point ID

* Coordinates - easting, northing and ellipsoidal height
* Code ID

* 3D Coordinate Quality

An Export Formatstring can consist of both variables
and text.

=

»In the Tree-View open the Export Formatstrings folder and then
open the Fixpoint (TPS/GPS) folder.

1. Format Manages - [Noname1.FRT]

[} Fie View Fomst Oplons Window Help

EEEREEETEEE)

»Select the Fixpoint

Exportstring. B
=) G |
& Fi hosdr
B File Footer
=4 Blocks * Insert export variables. N A

[ Baseiine Infomation (GP'S)
[ Code[TPS/GPS)
[ Date/Time Infomation (GPS)

Datablock-Type

[ Event Iformation (5PS)
B Fispoint [TPS/GPS)
[ Job (TPS/GPS)
[ Qualty information (GPS)
[ Satelite Iformation (5PS)
=149 Export Fomatstings
& Baseiine Infamation (GPS) —
-Gy Code (TPS/GPS]
& & DateTime Infomation (5PS)
l @ Evert Inomatien GF5)

Avaleble variables
[Abs. Convergence ange (dea] =
iceg)
o e —
s WS4 pas. lon (deg]
Blccknurber (651)
CLbS!

Combined scale factar

S Convergence angle
e _ oo Convergence angle [deg] =l
< Quality mrmmalwnn (GPS)
- S atelite Information (GPS)
© o
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When you select an Export Formatstring, the Insert
export variable dialog box becomes active. This
allows the different variables you need for a format file
to be chosen.

=

The first variable needed in this format file is the Point ID (Target)
variable.

»Scroll the list box to find the Point ID
(Target) variable. Select this variable either
by double clicking on it, or by highlighting it
and then pressing Insert.

+ Insert export variables.. T 1 |

Datablock-Type

Fispoint (TPS/GPS) =

Available variables

Local posiion lngiude
Modiied Easting
Moiied Northing

Fos. Lal. Hemisphere
Pos. Lo, Hemisphere

Frojection seale factor [
Target (East]

Target (North]
[WiE584 Elipsoid height |

Insert

The Point Id (Target) variable will appear in the Edit-View.

In the Format String Preview screen you can see how this
variable will look when the format file is used (Format Manager uses
a dummy point ID value).

[Z) Fie View Fomst Options window Help

Dfs{Ell| 2] sils] 2pel—
«Point ID (Target)»

pot Fomalstings
Baseline Infomation (GPS)
Cade (TPS/GPS)
Date#Time Infomation (5PS]
p EvertInfomalion (5PS)
£ Fispoirt (TPS/GFS)

[ Esporsting
Gp Job [TPS/GF5
Qualty irformation [GPS)
Satelte Information (GFS)

—
PFP123-98
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Export Variables that have been selected are shown
in the Edit-View with << >> brackets.

=

For this format file, we only require 6 characters of the point ID to be
output. (No point ID in our surveyed data has more than 6
characters). We also require the point ID data to be left aligned.

»Double click on the Point ID (Target) export variable in the Edit-
View. The Formatting options for export variable dialog box will
appear.

Formatting options for export variable [2]x]
458thngs'| Flags |

Mame:  PointID [Targel]

g

Aligment: R =] Lengh [l

Fepresentation = moere 0

Sign | =l Filcharacter:  [Spaces  x]

Alemate format: hd

u
[ This wariable has no urit
Cancel Help

Note that because Point ID (Target) is a String (text)
variable, the Representation, Sign, and Alternate
Format options are grey. These settings only apply to
Floating Point (numerical) variables such as grid or
geodetic coordinates.

=
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»Select the Alignment to be
Left.

»Choose the Length to be 6
and the Precision to be 6.

>Click OK.

Formatting options for export variable HES
{Seliiice ] Flags |

Name:  PointID (Targel)

Aligrment: Left ~l Length &

Riepiesertation 2| Feasn 6

Sigrs ] Filchaacter,  [Fpaces =

Allemate format: £

This vaiable has no uri ‘
Cancel Help

The example point ID in the Format String Preview screen will now
apppear as left aligned with only 6 characters.

B Format Manager - [Naname1.FRT]

File View Fomat Options Window Help

DS B &7 S| 78
-4 Header
-4 Export Fomatstrings

-G Baseling Information (GPS]
& Code (TP3/GPS)
@3 Date/Time Information (GPS]
& Event Information (GPS)
=& Fispoint (TP5/GPS)

L Expoitsting
-G Job [TPS/GPS]
< Qualiy infomation [GPS)
- Satelite Information (GFS)

=

manual.

Peoint - I (Target) [y

A full description of using the Default settings for
variables dialog box is given in Appendix A of this

Getting Started with Format Manager-1.1.0en

We now need to enter the coordinate variables.

»Click in the Edit-View screen to put the cursor behind <<Point ID
(Target)>> variable.

»Enter a tab which will separate the <<Point ID (Target)>> export
variable from the easting export variable.

1. Format Manager - [Noname1.FRT]

[ZI Fle View Fomat Opiions Window Help

D|=l@(m] ] slnls] 2heb—~

5@ Header Point ID

arget) s

i I B

 Insert export variables...

Hpon Fermatstings

Baselne Irfomalio

Code (TPS/GPS)

Date/Time Irfoma,

& Event Information [

- Fispoint (TPS/GPS [ Fp1z5-50 Losal postion lengiude =l
By Exportsting Modificd Easting

Datablock Type

Fispoint (TP /GPS) E

Avalable varizbles

Qualty nformation
& satelite Informatior

WS84 Elipsoid height =l

Before entering the coordinate variables, we should consider
something.

Previously, after we had entered the variable <<Point ID (Target)>>
we then had to set the alignment and the length and precision by
using the Formatting options for export variable dialog box.

This was because the default settings for alignment, length and
precision were not as we required.

It is possible to set the default settings for a newly selected variable.
This would then mean we do not have to set the format settings
individually for each of the coordinate export variables.
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>From the Options menu or from the Toolbar select Defaults |{i] If you require these settings also to be applied to
subsequently created format files, select the Apply to

The following dialog appears - these are the current output settings every new format option.

that will be applied to any variable which is selected:

Default settings for variables =]

] »Ensure the Apply to every new format option is selected.
Formatting opt
signcr: [EINE] L [ > Click OK.
sion [Onlregaive =] i charater [spaces =]
Altemate format: | Yes B

We can now enter the easting, northing and height export variables.

I Lse for every new fomat

< Insert export variables... S [

»From the Insert export variable dialog

e box insert Target (East). sl _
However, the next 3 variables we will enter will be easting, »Enter a tab. Aveleble varcbles
northing and height. For these 3 variables we require the same
format settings: Alignment to be left, the length to be 12 and the
precision to be 3.

Fos. Lon. Hemisphere
iojection scale factor

Targe! [Elev)

»From the Insert export variable dialog
box insert Target (North).

/G584 pos. . (sec) |
>Edit the settings to those shown below. >Enter a tab. |
Dot solings forvaiabls
ED;‘IMI »From the Insert export variable dialog box insert Local
N o ,l: Ellipsoidal Height.
T = e >Enter a tab.

i)

@ Ensure you choose the Local Ellipsoidal Height
export variable not the Target (Elev) export variable.

Cancel
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If you select a wrong export variable, put the cursor to the right of
that export variable by clicking just behind it and press Backspace.
This will delete that export variable.

You should now see the following:

% Format Manager - [Noname1.FRT]
[E) Fie View Fomat Options Window Hslp

D|=|a[B] &2 Sk 2]
4 e

=4 Hr «Point-ID- (Target)»-«Target-(East)»-«Target - (North)»-cLocal-E1lipsoid-Height»>-

123-95 140123.877 5123333.565 1463451, 134

»Double click on Local Ellipsoidal Height. The Formatting
options for export variable dialog box will show the default
settings you have previously set to be the default.

»Click Cancel.

=

To output a Local Ellipsoidal Height in a format file, use
the Local Ellipsoidal Height export variable. For this
format file we need the local ellipsoidal height. This is
because the sample data we will use with this format
file has local ellipsoidal heights, not orthometric
heights.

To output a local orthometric height in a format file, use
the Target (Elev) export variable.

=
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We now need to choose the Code ID export variable. This is stored
in the Code data block type.

=

To make export variables easier to find in the Insert
export variables dialog box, they are sorted into
different data block types. For example all code
information is stored in the Code (TPS/GPS) data block
type whereas all quality information is stored in the
Quality information (GPS) data block type.

Put the cursor behind the Local Ellipsoidal Height export variable
and the tab by clicking in the Edit-View.

»From the Insert export variable dialog box select the Datablock-
Type to be Code (TPS/GPS).

3 Insert export variables... H HE B

/@uckTh
[Code (TPS/GPS) =l
Ayaila iables
inite Home 2 B
ﬁ::ugu:e NameaB
»Scroll the Available variable list box to e
find Code ID. Double click on the Code R
ID or highlight the variable and click Fomt awotalon 2 ﬁ
Insert. Point annatation 4
>Enter a tab.
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The format settings for the Code ID export variable are however
again different to those we have previously set to be default. Thus
we need to edit the format settings for the Code ID export variable.

»Double click on the Code ID to activate the Formatting options
for export variable dialog box.

»Select the Alignment to be Left.
»Choose the Length to be 4 and the Precision to be 4.
»>Click OK.

You should now see the following:

[ Format M anager - [Noname1.FRT]

[Z) Fie View Fomat Options Window Help

Dl&[=e] =) Sl 2]

@ Header «Point-ID-(Target}»-«Target- (East)>-«Target- (Horth) »w«Local-E1lipseid-Height»-«<Code - IDx-|
E1-4 Export Formatstings

- Baseine Infomaticn (GPS)

G Cote (TPS/GFS)

& Date/ i

123-98 140123,877 5123333.565 1463451, 134 Tree

The final export variable to enter is the 3D Coordinate Quality.

* Insert export variables... 21}

Datablock-Tupe

»From the Insert export variable
dialog box choose data block type
Quality information (GPS) and the
export variable.

| Qualiy information (GPS) =

Awailable wanables

[4ss. EE - Drientation [Deq)
[4ss. EE - Drientation Min]
b EE - Orientation (Sec)
b EE - Semi Major A 3]

»Double click on the 3D Coordinate
Quality or highlight the variable and click

b5, EE - Semi Minor s (6]
Insert. Mean e of uril weight
Qi LI
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Because this is the final export variable we need to enter a carriage
return at the end of the line. This will ensure the information for each
point will start on a new line.

»Press Enter.

The format settings are again different to those we have previously
set to be default and need to be changed for the code ID.

»Double click on the 3D Coordinate Quality to activate the
Formatting options for export variable dialog box.

»Ensure the Alignment is set to be Left.
»Change the Length to be 5§ and the Precision to be 2.
»Click OK.

You should now see the following:

I Format Manager - [Noname1]

[E Fie View Fomat Options Window Help

EENEREEESRE]

#-4p Headsr «Point ID {Target)s-~«Target (East)»-«Target (North)s-<Local Ellipsoid Height:-«Code ID»-:3D Coordinate Quality»
14 Expot Fomatskings

130123377 5123333.535 14e34st. 33 Tree GED

/" ime Infornation (6PS) [ Fp125-55
5]

& Eventinfomalion
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It is of course possible to use this format file with surveyed points
that were not coded. For these points, a default value would be
assigned to these points.

It is possible to edit the default values that are assigned to points that
do not contain data for the export variables that are being used.

»From the Options menu or from the Toolbar select Formats @ .

The following dialog box will appear. Select the Default values tab.
This shows the current default settings.

Settings [2]x]

Scales | Links  Defauit valuss |

Floating Point defauit vaiue: | 1-00
Integer detaut vaus |07
Sting defauk value: |

I~ Use for every new format

Cancel

»Change the String default value to be NULL.

This means that when this format file is used, any point surveyed
without a code will be given the value NULL.

»>Click OK.
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It is also possible to change the default values for
Floating-Point variables (such as coordinate values)
and Integer variables (such as angular values). Refer
to Appendix B for a complete description of the use of
the Settings dialog box.

=

The export formatstring and the format file is now complete and
needs to be saved.

»From the File menu choose Save as...

»Choose the directory where you wish to save this format file. Give
the format file a file name and click OK. The .frt extension is
automatically added.

Save As [z]x]
Saveir | FomatManager - ¥
Filname:  [Quick Tou FRT Save
Save sspe: [ Fomats (-] 2 Cancel

It is recommended that all format files are stored in the
same directory.

=
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Congratulations! You have created a Report Style format file that When you export the sample data using this format file, you should
can be used with either SKI-Pro or on board the System 500 sensor. see the following output. If you do not, check the format file to
identify the problem.

It is recommended that you use the Real Time sample data to test this ~ Comeany Hanme Conpany Address
format file. Import this sample data into SKI-Pro and then export the RTH Survey Report
data using this format file. PtId  Easting Northing Height code  3DEQ
1 H o881 1881360.278 5248334.959 463.632 EB a.81
If you are not sure how to use the format file in SKI-Pro, please refer ;5o Jogisueicss  soupsas.uss  asa.re e o0
to the Quick Tour | in the Getting Started with SKI-Pro user 9003 1801331.193 5248338127 468841 EB 8.01
2884 1881316.365 5248341.946 463.932 EB 8.81
manual. 90805 18681306450 5248348189 463.945 EB 0.61
2886 1881296.992 5248357 .587 463.812 EB 8.82

When you installed SKI-Pro, the sample data should have been
installed on your PC in the directory:

@ The best way to test a format file is to use any sample
data and inspect the output. The format file can then be
edited until you are satisfied with the output.

\SkiPro\Data\SampleData\Sys500\Realtime\.
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Quick Tour Il - Creating a Leica GSI16 Output for use with Thematical Coding

Quick Tour Il is a step-by-step tutorial to create a format file that will
output data in the standard Leica GSI16 format for use with
thematically coded data.

Quick Tour Il follows on from what you have learnt in
Quick Tour I. If you have not yet completed Quick Tour I,
it is recommended that you do so.

=

Note, this format file can only be used with data that has been coded
using Thematical coding. This format file could not be used with
data that was surveyed using Free coding. No code information
would be output.

A GSI16 format file that can be used with data that has been coded
with Free Coding will be created in Quick Tour III.

A brief overview of the differences between Thematical and Free
coding is given here. For a full description, please refer to Chapter 8
of the System 500 Technical Reference Manual which can be
found on the SKI-Pro CD.
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A brief overview of the differences between
Thematical and Free Coding

Thematical coding means that when a point is coded in the
field, the code information is directly connected to that
surveyed point - it is a "property" of the point. For this reason,
the code export variables have to be entered into the Fixpoint
(TPS/IGPS) Export Formatstring.

When thematically coded points are exported with this format
file, any code information connected with the surveyed points
is also output.

=

Thematically coded data can be sorted by time or
point ID when exported from SKI-Pro or the sensor.

Free coding means that when a code is selected in the field,
that code is given only a time stamp. It is not connected directly
to any surveyed point. For this reason, the code export
variables have to be entered into the Code (TPS/GPS) Export
Formatstring. When free coded survey data is exported it
must be sorted by time.

When the data is exported, both the codes and the surveyed
points will be exported in exactly the same chronological order
in which they were collected in the field.

=

Free coded data must be sorted by time when
exported from SKI-Pro or the sensor.
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The output shown below is required.

In this format, the Export Formatstrings consist of both text and
export variables. For each point, the code data is output on one line
and then the point ID and coordinate data is output immediately on the
following line.

Incrementing .
block number Code ID Attributes 1,2 and 3
ree QL -t aae Y ¢
COde data a ree i;"“" e 02--1u+ aae '-Ifl““" a8
) ﬂl]l]ﬂ2 E1::1l]+nl]ﬂlll]ﬂll76!|292596 E2::1l‘]+ 52987796 Eﬂ;ﬂ 115568608
POInt ID and *11 ﬂﬁfﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂpﬂﬂﬂ[ﬁ E1::1l]+nl]ﬂlll]ﬂll76!|29!|527 E2::1l‘]:ﬂﬂnﬂm][1253£|l]!m76 ::::‘;I‘hﬂﬂﬂﬂﬂﬂﬂﬂﬂﬁSSMh
coordlnates :ﬂanggmaauaanaaupauoau 81::10+DBBIWBII76!|29!|572 82::16:3003003253003635 83::;6+BBBBBBBBB1155635
;ﬂ 33?3%:.%0., Bnoas)!:i oA n@nnuziﬁ?)ﬂ: :162@360252993)05?%: :i@'{nguaauaannssﬁb‘m
T T T T
Point ID Easting Northing Height
* The length of the output variables must always be exactly 16. If the
Note also the following characteristics of this format file: surveyed data contains less than 16 characters for any variable then
) ] ) ] the "fill" character must be 0. If the surveyed data that is output using
* This format file does not include a Header, Block Titles or a this format file contains more than 16 characters, then the data must
Footer. It contains only one Export Formatstring. be truncated.
* The Coordinate values are output in mm values and contain no * Attributes 2 and 3 for points p00003 to p00005 were not given a
decimal point. value when surveyed. In the output above, they are given a "default
value" of 0.

* All variables are right aligned.
* Each line contains an incrementing number - the GSI block
number
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Lesson One - Creating the Export Formatstring - Code Information

Choose to create a new format file. The first part of the code line is the text *41. This is not an export

variable, but simply text.
»From the File menu or from the Toolbar select New g >Enter the text *41

»Click OK to create a standard GPS 500 format file.
»Expand the tree view and select the Fixpoint (TPS/GPS)

: The next part of the code line is an incrementing block number. This is
Exportstring. effectively a line counter which increases by 1 for each line that is
output.
»>From the Insert export variable list box, choose Blocknumber
[Z) Fle View Fomat Options Windo (GSI)
D|={Eey| e[| Sl :
-4 Header

-4 Export Formatstings
< Baseline Information [GPS)
< Code (TPS/GPS)
< Date/Time Information [GPS)
<Zp Event Information [GPS)

[BiFomat Manager - Nonamett |
Ele View Fogal Oplions Window Help
D[R] &2 slxs] 2|
o 4 Header “41lyBlocknumber (GSI)»
[Ef (=4 Export Fomatstiings
> B -Zp Baseline Information (GPS) illnzeiliexp oilivaishlo= il Sl =
& Qualty information (GPS] Code [TPS/GPS)

i Date/Time Information [GPS]
<Zp Satelite Information [GPS) G Event Information [GPS)
[=-&p Fispaint (TPS/GPS]

[y Exportstiing
Job (TRS/GPS)
DQually information (GPS)
Satelite Irformation [GPS)

Datablock-Type

Firpoint TPS AGFS) -

Available varizbles

(Ebs. Convergence angle [deg]
Abs. Local pos. lat (deg)
Abs. Locl pos. lon [deg]

(b WESBA pos o e
CLESS

We will enter the code export variables into the

@ Fixpoint (TPS/GPS) Export Formartstring because this
format file is for use with data surveyed using
Thematical coding.
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»Double click on the variable to access the Formatting options
for export variable dialog box.

»Set the format options as shown below.

Formatting options for export variable [z]x]

Settings | Flags |

| Mame: Blocknumber (GS51) |
Alignment: Right ~|  Lengh u
Representation: | Precision: o0
S Onl negative | Fillcharacter, [N
Alemate format: :l'

u
’7 Thi ble h it

Note that when you choose to right align a variable you
can choose between a space or zero as the fill
character. For GSI formats, the fill character will
always be zero.

»>Click OK.

The next character is a + sign immediately after the Blocknumber
(GSI) export variable.

»Enter a +.
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The remainder of the export variables in this line are the Code ID and
Attribute values 1, 2 and 3 all have the same format.

They are all Right aligned, with a Length of 16, a Precision of 0
and use the Fill Character of 0.

Remember that it is possible to set the default format values for
export variables.

»From the Options menu or from the Toolbar select Defaults |ﬂ;%|

»Set the format options as shown below. Ensure to click the Use
for every new format option.

Expot | Flags |
Faimatting opt
Alignment: [Right - Length: |16
R tatiors [Nomal - o
epresentation:  [Nomal preciion. |9
Sigre | Only negative ]‘ Fill character: {0 [
Atemate fomal; [ es -
IV sz for every new fomat

Instead of setting the length of the variable to be 16,
you could also set the length of the variable to be 8 and
then enter 00000000 as text. The output would be
exactly the same.

=
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We must also ensure that the number of characters output for any
export variable is never more than 16. GSI16 format does not allow
any export variable to be greater than 16 characters in length. We

must therefore set the truncate flag.

»>Select the Flags tab view and tick the Truncate value option as
shown below.

»Set the format options as shown below. Ensure to click the Use
for every new format option.

Default settings for variables

Ewport Flage |

Flog |
[ Allow scaling

ounding

Cancel

As mentioned at the beginning of the Quick Tour, any "gaps" in GSI16
format must be filled with a 0. This means that we must ensure 0 is
output for the points where codes or attribute values are not
available.

»From the Options menu or from the Toolbar select Formats ﬂ .
»Select the Default values tab. Change the settings to those
shown below.

Settings [7]

Scales | Uinks | Defouit vaiues |

Floating Point defaul value: |0
0

Inkeger defoutt value:
Stiing defauk value: |0

This means that when this format file is used, any point without a
code or attribute value, the code and attribute output will be 0.

»>Click OK

=

»>Click OK.

=)

A full description of using the Default settings for
variables dialog box is given in Appendix A of this
manual.

A full description of using the Settings dialog box is
given in Appendix B of this manual.
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»From the Insert export variable list box, choose Code ID.
Remember to select the Code (TPS/GPS) Datablock-Type first.

i Format Manager - [Noname1]

B Fle View Fomst Oplions “indow Help

D @e] e Ml 2%

@ Header *41<Blocknumber {GSI)»+<Code ID:

=€ Export Fomalsings N e s 2 [
G Baseline Information (GPS)
G Code (TPS/GPS)

G DatesTime Information [GPS) ———————————— | Dalablock-Type
+410001+0000000000Tree0l

G Event Irfomslion (GPS)

(- Fispoint (TPS/GPS) Code [TPS/GFE1 =]
0 Exportsting Available variables

G Job (TPS/GPS]

G Qualty informtion (5PS)

& Stelie Infomation (GP5)

[Attibute Name 6
[Aitibute Name 7
[itibute Hame 8
[ Attribute name 9
Cods description

Coding layer

»Enter a space and then the text 42....+

Complete the rest of the code line as shown below. Ensure you
select the Attribute value export variables, not the Attribute
Name export variable.

#41cBlocknumber (BSI}»+«Code ID»-4Z....+wAttribute 15-43....+cAttribute 2»-44....+dttribute 3»-

+410001+0000000000Tree0l 42....+000000Actributel 43....+000000Accribucez 44....+000000Accributed

All GSI16 output requires a space at the end of the line.

»At the end of the line enter a space and then press Enter.
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Lesson Two - Creating the Export Formatstring - Coordinate Information

The first part of the coordinate line is the same as the code line. It
again consists of text and the Blocknumber (GSI).

»Enter the text *11 and the Blocknumber (GSI) as described for
the code line in Lesson One.

Remember to set the format settings for the blocknumber as in
Lesson One.

1. Format Manager - [Nonamel.FRT]

[Z) Fie View Fomat Options Window Help

D[] &) Slisle] 2|

-4 Header *41«Blocknumber - {6SI)»+«Code-ID»-42. ..
-4 Export Famatstings *11«Blocknumber {BGSI)»+
&p Baseline Information [GPS)
&p Code (TPS/GPS) T
&p Date/Time Information (GPS]
&p Event Information (GPS)
E1-<p Fixpairt (TPS/GPS)
Exportsting
&p Job (TPS/GPS)

#410001+0000000000Tree0l 42....+00000C
7110001+

»Enter a + as text.

The next part of the line is the Point ID (Target). Enter the Point ID
(Target) export variable as shown below.

1. Format Manager - [Nonamel.FRT]

[Z) Fie View Fomat Options Window Help

D[] &) Slisle] 2|

-4 Header *41cBlocknumber - {GSI) »+«Code-ID»-42. ... +cAttribute-:
-4 Export Famatstings *11«Blocknumber {GSI)»+«Point ID {Target)»

Baseline Information [GPS]
Code (TPS/GPS) T
Date/Time Information [GPS)

@ Event Information [GPS)
E£1-Gp Fixpaint (TPS/GPS]
Expottstiing

Job (TPS/GPS)

- Qualiy information (GPS]
@ Satelite Iformalion [GPS]

#410001+0000000000Tree01 42....+000000AttEibutel 43
#110001+00000000PP123-98
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The next part of the line is the coordinate variables.

For metric formats, the GSI format allows no decimal point in the
output string which means the coordinates have to be output in mm.
However, the coordinate data that will be output from SKI-Pro or the
sensor will be in metres. It is therefore necessary to scale the
coordinate values by 1000.

»From the Options menu or from the Toolbar select Formats §|.

The Setting dialog box will appear. Ensure the Scales tab view is

selected.
export variable. (Normally, GPS users would only be
interested in scaling linear export variables such as
coordinate values or baseline lengths).

It is possible here to enter 4 differerent scale values for
Angular, Linear, Temperature and Pressure type

Settings [2]x]

Scales | Links | Defauit vaues |

roulascal 1R

T T
I —
I —

Temperature scale

Pressure scale:

I~ Use for every new format

Cancel

»Change the Linear scale to be 1000.
»>Click OK.
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We now need to define the Formatting options for the coordinate
export variables.

Since the easting, northing and height will all have exactly the same
settings, it is more efficient to set the default format settings that will
be applied to every subsequently selected export variable than to
enter each export variable and then individually set the format
settings for each variable.

»From the Options menu or from the Toolbar select Defaults |ﬂ;%|

Set the format options as shown below.

Expot | Flags |

Farmatting opt

Alignment: [Right - Length: [17
R tatiors [Nomal =
epresentation:  [Nomal Presision: [0
Sigre | Awaps =l Ftchascier [0 [~
Atemate fomal; [ es =

IV sz for every new fomat

Cancel

It is quite possible that a coordinate system could be used that may
produce negative values for any of the coordinate values. For this
reason the correct sign must always be included in the output.

»Choose Always for the Sign.
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A length of 17 is required because the sign of the export variable is
included in the export variable. Thus we will have 16 actual numeric
characters for the coordinate value and one character for the sign.

A precision of 0 is required because we do not want a decimal
point or any decimal values in the output.

»Set the Length to 17 and the Precision to 0.

Notice that we have set the length of the output to be 17. However,
if the actual length of the coordinate value that is output contains only
12 characters then the "missing" characters need to be filled. The
choice is to fill with either 0 or spaces. For a GSI format the spaces
need to be filled with 0.

»Set the Fill character to be 0.

»Ensure to select the Use for every new format option.
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»>Select the Flags tab view. »Enter the remainder of the coordinate line as shown below. Do not
enter the + charcter as text. Remember this will be output as part of

»Ensure the Allow scaling option is selected. the coordinate export variable itself.

This option means 'that any real or integer type export variable >At the end of the line enter a space and press ENTER
(coordinates, baselines, angular values...) will be scaled by the

appropriate factor that was entered in the Scales dialog box. In this
example, the coordinate values will be scaled by 1000.

=1 2]
[ +a1<Blocknumber - {BST) »+<Code -ID»-4Z . .. . +<ALtribute-1n-43 ... .+tcAttribute 2»- 44. . .. +Attribute 3»-
*11«Blockmumber - {BSI):+«Point-ID-(Target)»-581..10«Target-(East):-82..10«Target - (North):-83..10«Local Ellipsoid Height: -

Default settings for variables [2]x]

+410001+0000000000Tre=01 42. ... +000000AtEr ibucel 43....+000000AtEribucez 44....+000000AtEr ibuces

Flags
Export Flags | +110001400000000FP123-35 81 . 1040000000140123877 82 .. 1040000005123353565 83 .. 104000000145345113 4

Flag |
Allow scaling

L] Suppress rounding

Truncate value

The export formatstring and the format file is now complete and
needs to be saved.

»From the File menu choose Save as...

¥ Use ot gvepy nov faimat

»Give this format file a file name and click OK. The .frt extension is
_Coel | automatically added.

Ensure that the Truncate value flag that we set for
@ the code export variables is still selected.

»>Click OK.
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Congratulations! You have created a GSI16 format file that can be
used with either SKI-Pro or on board the System 500 sensor.

It is recommended that you use the Thematically Coded sample
data to test this format file. Import this sample data into SKI-Pro and
then export the data using this format file.

When you installed SKI-Pro, the Thematical sample data should
have been installed on your PC in:

\SkiPro\Data\SampleData\Sys500\Thematic Coded\.

When this sample data is exported using this format file, you should
see the following output. If you do not, carefully check the format file
to identify the problem.

*41000 ree 42._.. u3.... ub

=11 1 81..1 4295500 82. .1 19 83..1 1154987
11 ree 42. .. u3... 088 L4 .. 08
11 81..1 82..1 796 83..1 1550868
1 0ad 42.... 1 43.... uy,

11 81..1 64294527 82..1 83..1 y
*410007 0ad 42.... 1 43.... uy,

11 81..1 64294572 82..1 83..1

*u1 0ad 42.... 1 43.... uy,

*11001 81..1 82..1 83..1 1155454

@ The best way to test a format file is to use any sample
data and inspect the output. The format file can then be
edited until you are satisfied with the output.
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Quick Tour Ill- Creating a Leica GSI16 Output for use with Free Coding

Quick Tour Il is a brief tutorial to create a format file that will output
data in the standard Leica GSI16 format for use with free coded
data. The actual creation and the export variables used for this
format file is virtually identical to the format file we have just created
in Quick Tour I1.

Quick Tour Il follows on from what you have learnt in
Quick Tours | and Il. If you have not yet completed
Quick Tours | and Il, it is recommended that you do
so.

=

Note, this format file can only be used with data that has been coded
using Free coding. This format file could not be used with data that
was surveyed using Thematical coding. No code information
would be output.

We have already created a GSI16 format file that can be used with
data that has been thematically coded in Quick Tour II.

For a brief description of the differences between Thematical and
Free coding, refer to Quick Tour Il. For a full description, please refer
to Chapter 8 of the System 500 Technical Reference Manual
which can be found on the SKI-Pro CD.
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There is only one difference between this format file for use with
free coding and the format file created in Quick Tour Il for use with
thematical coding.

With this format file, the code export variables are entered into the
Code (TPS/GPS) Exportstring. With the format file created in Quick
Tour Il, the code export variables were entered into the Fixpoint
(TPS/GPS) Exportstring.
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The output shown below is required.

Note here that the code road was only entered once, immediately
before point p00003 was surveyed. Most CAD pakages will
interperate that subsequent points (p00004 to p00005) will also use
this code until a new code is entered. This is the correct way to
survey with free codes.

. Code ID Attributes 1,2 and 3
Incrementing
block number
BUBUBBUBUU‘EE .- L.
Code data +auaa o0UTT 81..10+0 82..16+ 3 83..10°BU0D06EE w7OT
*k1l]ﬂl]3+ﬂl]ﬁﬂl]ﬂl]ﬁﬂl]ﬂl]tree u2... 43... aee 44... .+ a8

=110604

peasa2 81..1 U+U[1[1“IW[I?6|;2931 a8 82..1 Ii+[l[1“[1[1“[1252985?[18 83..10+0000080001154976

Point ID and
coordinates

%41 0BO5+HOBBOBDOAOOOF0ad 42 . .
=11 [Iﬂﬂﬁ+ﬂﬂl]ﬂﬂﬂﬂl]ﬂﬂpﬂ[lﬂﬂﬂ 81.

*110007+0000080680p-806844 81.
*110008+0QBA0ABABAP OARAS D1.

Point ID

1 43...

L

.1 ﬂ+ﬂ[1[1ﬂ|]ﬂ[|76|l291l51 a8 82,

- 18+ 00006648 82.
-18+04 l]ﬂl]l]?ﬁll29!|658 g2 .

Easting

-1 I]+[I[1“[1[1“[1253“I]3856 83.

-168+0648 89 83.
.1ﬂ+l]ﬁﬂl]ﬂ252991lll15 B3 .

Northing

| [1+[1“[I[1“I][1[I[11155813

.18+ 00980
.10+ l]l]ﬂl]ﬂﬂl]ﬂ1155382

Height

The characteristics of this format file are identical to the format file
created in Quick Tour II:

* The length of the output variables must always be exactly 16. If the
surveyed data contains less than 16 characters for any variable then
the "fill" character must be 0. If the surveyed data that is output using
this format file contains more than 16 characters, then the data must
be truncated.

* This format file does not include a Header, Block Titles or a
Footer. It contains only two Export Formatstrings.

* The Coordinate values are output in mm values and contain no
decimal point.

* Attributes 2 and 3 for the code road were not given a value when
surveyed. In the output above, they are given a "default value" of 0.

* All variables are right aligned. * Each line contains an incrementing number - the GSI block

number
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Lesson One - Creating the Export Formatstring - Code Information

Choose to create a new format file.

»From the File menu or from the Toolbar select New g
»Click OK to create a standard GPS 500 format file.

To create the export formatstring for the code information, repeat
exactly what you did in Lesson One of Quick Tour Il. The only
difference is to enter the code information into the Code (TPS/GPS)
Exportstring.

=

We will enter the code export variables into the Code
(TPS/IGPS) Export Formartstring because this format
file is for use with data surveyed using Free coding.

»Expand the tree view and select the Code (TPS/GPS)
Exportstring.

[} Format Manages - [Noname1.FRT]
Fie ‘iew Fomat Options ‘Windav

D[=(Ee] & Sl
-4 Header
-4 Export Formatstings
<7 Baseling Information (GPS]
=)-4Z» Code (TPS/GPS)
B Exportstring
<Zp DatedTime Information (GPS)
<Z7 Event Information [GPS)
<7 Fispaint [TPS/GPS)
<Zp Job [TPS/GPS)
<Zp Quality infarmation (GPS]
<Zp Satellite Information [GPS)
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To enter the code and attribute export variables, repeat exactly what
we did for Lesson One of Quick Tour Il. Refer back to this lesson if
necessary.

=

Note, that when you activate the Formatting options
for export variable dialog box, many of the settings
will be correct. This is because we ticked the Use for
every new format option in Quick Tour Il.

After creating the code information export formartstring, you should
see the following.

*41<Blocknumber - (GST) »+«Code - ID»42. - . -

41000 Tres0l 42.... 1a3.... Frav.
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Lesson Two - Creating the Export Formatstring - Coordinate Information

We now need to enter the coordinate information. Again, this is
identical to what we did in Lesson Two of Quick Tour II.

»Expand the tree view and select the Fixpoint (TPS/GPS)
Exportstring.

[ Format Manager - [Noname1]

E\\e “iew Format Options  ‘windo

) T s R A N

-4 Header

-4 Export Formatstings
Zp Baseline Information [GP5)
Gp Cods [TPS/GPS)
Zp Date/Tims Information [GPS)
<Zp Event Information [GPS)
E1-<Zp Fispaint [TPS/GPS)

[ nE "
«Zp Job [TPS/GPS)

«Zp Quality information (GPS)

<3 Satellite Information [GPS)

To create the export formatstring for the coordinate information,

repeat exactly what you did in Lesson One of Quick Tour II. Refer
back to this lesson if necessary.

Quick Tour Ill - Creating a Leica GSI16 Output - Free Codes

After creating the coordinate information export formartstring, you
should see the following.

.. ZET O

=QE PS)
=& Fixpont (TP /GPS]

Once you have completed entering the coordinate information, save
the format file.
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It is recommended that you use the Free Coded sample data to test
this format file. Import this sample data into SKI-Pro and then export
the data using this format file.

When you installed SKI-Pro, the Free Coded sample data should
have been installed on your PC in:

\SkiPro\Data\SampleData\Sys500\Free Coded\

When this sample data is exported using this format file, you should
see the following output. If you do not, carefully check the format file
to identify the problem.

*410001 ree 42.... u3.... 4.

=11 1 81..1 64204216 82. .1 1543 83..1 1154798
*41080863 ree 42 .. L 6080 44 .. a8
*110004 p 81..16 64293108 82. .10 788 83..10 1154976
=41 oad 42.... 1 83.... L L

*110666 p 81..186 64204518 82. 16 83..186 1155813
*110007 p 81..16 64294541 82, .10 83..10 11 9!
=11 81..1 82..1 15 83..1 115538

@ If you do not see any code information, it is possible
that you have selected in the export setting options in

SKI-Pro to sort the data by Point Id. Export the data
again, this time sorting by Time.
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Appendix A - The Formatting Options for Export Variables

This Appendix describes the different format options that are
possible using the Formatting Options for Export Variables
dialog box. Double click on any export variable to access this dialog
box.

Formatting options for export variable [z]x]

£5iiigs | Flags |

Hame: Faint D (Target]

9
Alignment: | T [io
Repeseniaion: | ] Precision i

Siar: [ =l Filchascter,  [Spaces 7]
Alemate format: j'

Cancel Help

The use of the options within this dialog box allows a large number
of different output formats to be created.

As mentioned in Quick Tour | only all format options are available if
the selected export variable is a Floating point export variable. This
type of variable normally contains a decimal point and a decimal
value. An example of such an export variable is Coordinate
(Easting).

If the export variable is a String (text) variable or an Integer
variable then not all format options are available. An example of a
String variable is a Point ID. An example of an Integer variable is
the degree part of the Latitude of a point.

In the following descriptions of each format option it is stated if that
option is applicable to String and/or Integer export variables.

Appendix A - The Formatting Options for Export Variables

It is possible to set the default Formatting Options for Export
Variables. From the Options menu or from the Toolbar select

Defaults |i] .

Default settings for variables [z]x]
Export | Flags |

Formatting opt

Algnment: [Right - Lengt [T
Nomd =] Precision 0

Sian: | Always = oz [0 3
es B

(¢ ¥ Dsgfor Evev@

Representatior:

Altemate forma;

Cancel

You can then define the formatting options that will be applied to
every subsequently selected export variable for that particular
format file.

Additionally, if you wish those formatting options to also be applied
and used in every subsequent format file you create, you should
select the Use for every new format option.
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Settings

This section describes the options that are available on the Settings
tab view of the Formatting options for export variables dialog
box.

Formatting options for saport variable
(%eings | Flags |
Name:  Target [East)
g
Alignment: Right =] Lenat: 5
Representation  [Nomal =] Precision i
Sian: [ainays =] Filcherseter [0 = |
Abemate fomai: [Yos -
U
’V Meter =] Use system urit
Corcel_|_Hob

The alignment defines the orientation of the string within the defined
string length. Applies also to String and Integer export variables.

Example (using Point ID of 12345678):

12345678
12345678

Left alignment -

Right alignment -
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Representation

The representation allows a decimal or an exponential representation
to be chosen. Does not apply to String and Integer export
variables.

Example (using Easting of 609.173):

Normal - 609.173
Exp. basis e - 6.092e+02
Exp. basis E - 6.092E+02
Sign

The sign controls if a sign (+ or -) will be output with the export
variable. Does not apply to String export variables.

Example 1 (using Easting of 123456.123):
Only negative - 123456.123
Always - +123456.123

Example 2 (using Easting of -123456.123):
Only negative - -123456.123

Always - -123456.123
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Alternate Format

This is a functionality which may be introduced in the future. It has no
function at the present time.

Length

Defines the minimum length of the output. This length includes the
sign (if selected to use) and the decimal point. Applies also to String
and Integer export variables.

Length 0 is not allowed. Maximum length is 20.

See below in the description of Precision for examples of using the
length.

Precision

This has different meaning for String and Integer variables and
Floating point variables.

String and Integer variables: Precision defines the maximum
length of the output.

In the examples below, the output is shown for both using
truncation and not using truncation is shown and uses 0 as the
fill character (both truncation and the fill character are explained
later).

Appendix A - The Formatting Options for Export Variables

Examples (using Point ID of 12345678):

Length Precision Truncation Output

5 0 No 12345678
5 0 Yes 45678

5 3 No 00123

5 3 Yes 00123

5 5 No 12345

5 5 Yes 12345

5 7 No 1234567
5 7 Yes 34567

It can be seen that using the correct length, precision and the
truncation flag, any output can be achieved.

=
=

Floating point variables: Precision defines the number of decimal
places of the output. The examples below use a fill character of 0

Note how a precision of 0 does not set the maximum
length - the whole string is output (truncated if the
truncation flag is set).

If the length is greater than the precision, the remaining
spaces are filled with the fill character.

Examples (using Easting of 123456.12345):

Length Precision Output
15 3 00000123456.123
15 6 00123456.123450

Note that the length of 15 includes the decimal point.
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Fill Character

Fill characters are used to "fill" variables that have fewer characters
than the defined length for that variable. Applies also to String and
Integer export variables.

Either spaces or 0 can be used as the fill character.

In the example below, the output is right aligned and has a length
of 7.

Examples (using Point ID of 12345):

0 as fill character - 0012345

space as fill character - 12345

The space fill character is automatically selected if a
variable is left aligned.

=
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Units

The unit type as to how the data will be output for each variable can
be defined. This setting will overide any unit setting in SKI-Pro or on
the sensor. Does not apply to String export variables.

Linear variables (such as coordinates, baseline lengths) can be set
to metres, US feet, or Intl feet.

Angular variables (such as convergence angle) can be set to
radians, gons, degrees (sexagesimal), degrees (decimal) or
mils.

The Use system unit will read the instrument settings regardless of
the Format Manager settings for that variable.

U
’7 [tieter =l flise system i
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Flags

Flags are special "attributes” that can be set to export variables to
increase the flexibility of the output format.

Formatting options for export variable

Flag

Allow scaling
[ Suppress rounding
[ Truncate value

Some flags are not applicable to String and Integer export variable
types. For each flag it is stated in the following descriptions if that
flag is applicable to these export variable types.

Allow scaling

If this option is selected, variables will be multiplied by the entered
scaling factor. Does not apply to String and Integer variables.

In the examples below, the linear scale is set to 1000.
Example (using Easting of 123456.789):
Flag Enabled (use scaling) - 123456789.000

Flag Disabled (do not scale) - 123456.789

The scaling factors themselves are entered in the
Settings dialog box. (From the Options menu or from

the Toolbar select Formats ﬂ ).

=
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Suppress rounding

If this option is selected, the true value will be truncated (instead of
rounded) at the specified precision. Does not apply to String and
Integer variables.

In the examples below, the Precision is set to 2.
Example (using Easting of 123456.789):
Flag Enabled (rounding suppressed) - 123456.78

Flag Disabled (rounding not suppressed) - 123456.79

Truncate value

If this option is selected, variable values will be truncated to reach
the desired string length. Applies also to String and Integer
variables.

In the examples below, the Length is set to 7.
Example (using Easting of 123456.789):

Flag Enabled (truncate) - 456.789

Flag Disabled (do not truncate) - 123456.789

=

For Floating Point variables the truncation is always
from the left. For String and Integer only variables,
the text can be truncated from the left or right
depending on the Length and Precision settings.
Please refer to the previous description on Precision.
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Appendix B - The Setting Options

Scales

This Appendix describes the different format options that are
possible using the Settings dialog box. This is accessed from the
Options menu or from the Toolbar select Formats ﬁl .

Settings 2] %]
Scalagl Uit Default values I
—alu
Floating-Point default value: 1.00
Integer default value: 1.00
Stiing default value: I'I
— Walidit
I Use far every new farmat

The use of the options within this dialog box allows the Units,
Scaling factors and the export variable Default values to be set.
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Scales can be defined for all export variable types. All export
variables will then be mutiplied by the specific scale factor.

Sellings [z]]

Scales |Urits | Defaut values |

« scale 100000000
Temperature seale: 1.00000000
Pressure soale: 1.00000000

| I Use for every new fomat ‘

Cancel

Example (using Easting of 123456.12345):
In the example below, the linear scale is set to 1000.

Output - 123456123.45

If you wish to use scaling for an export variable,
@ remember to set the Allow scaling flag for that export

variable. Refer to Appendix A.

If you wish the scaling values also to be used in every
@ subsequent format file you create, you should select
the Use for every new format option.




Units

Default values

The units for angular, linear, temperature and pressure units can be
selected. The output will then be converted into the selected units.

Settings
Scales Unks | Defouit vaiues |
U

Angularunit; [Gon -

Linear urit: Meter jv
Temperature unit; | Degress Celsius =

Pressure urit: mBa jv

I Lise for evety nem fomak I~ Use instiument units

If you wish the unit settings also to be used in every
subsequent format file you create, you should tick the
Use for every new format option.

=
=

If you wish the units which are currently chosen on the
instrument or in SKI-Pro to be output, you should select
the Use instrument units option.

Appendix B - The Setting Options

This allows the default values to be defined that will be output for
Floating Point, Integer and String export variables.

Settings [2]x]

Scales | Links  Defauit valuss |

Floating Point defauit vaiue: | 1-00
Integer detaut vaus |07
Sting defauk value: |

I~ Use for every new format

Cancel

»Examples of Floating Point variables are coordinate or
baseline length variables. They are variables which could contain
a decimal point in their output.

»An example of an Integer variable is the degree part of the
WGS84 coordinates. They are variables which do not contain a
decimal point in their output.

»Examples of String variables are Point ID or Code ID. They are
purely text variables.
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The default value you enter will be output when that variable type

(floating point, integer or string) is output but no actual data for that
particular variable is available.

For example, a simple format file is created which will output point ID,
coordinates and code. However, during the survey, not every point is
coded. When the format file is used with this survey data, the code
ID that will be seen in the output for the points that have not been
coded will be the default value.

@ If you wish the default values you enter also to be used
in every subsequent format file you create, you should
tick the Use for every new format option.
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Appendix C - Frequently Asked Questions

Q. Why has my data not come out on separate lines? It has
scrolled around the screen.

This is because you have not pressed ENTER at the end of the
output string. You must enter the complete output for a format file and
the carriage return / line feed to create a new line is part of that
format. This also applies to any footers, headers or block titles.

Q. Why do | see 1.00 for my local heights? | can see the
proper heights in SKI-Pro.

You see 1.00 because this is the default export value for floating
point export variables when you install Format Manager. This means
that the export variable you have selected does not contain data.
Check you have selected the correct export variable for your local
height.

Remember the Target (Elev) export variable will output local
orthometric heights. The Local Ellipsoidal Height export variable
will output local ellipsoidal heights.

B Format Manager - [Noname2]
[Z3 File View Fomal Options ‘wind

D2 |Ee| 2] &l

Q. Why are there so many export
formatstrings in the tree view? Do | always
have to use the Fixpoint exportstring folder?

@ Header
[ER & £ oot Formatstrings

Baseline Information (GPS)
Code (TPS/GPS)
Date/Time Infamation (GP$)
Event Information (GPS)
Fispoint (TPS/GPE)

Job (TPS/GPS)

Quality infamation (GPE)
Zp Satelite Information [GPS)

Using the different formatstring "folders" allows
data of certain specific types to be grouped
together.

Appendix C - Frequently Asked Questions

Example:

You require GPS data to be output in a format that is similar as
shown below

Job Details...

Name of job, Creator etc
Point Details...

Point ID, coordinates, CQ etc
Baseline Information...

Baseline lengths etc

Each "type" of data (Job, Point details, Baseline information) is
grouped together in blocks which allows complex format outputs to
be created.

However, the vast majority of format outputs can be created by just
using the Fixpoint folder.

Not every export variable can be used in every folder.
For example the Baseline Cofactor Qzz export
variable could not be used in the Job folder. The
baseline cofactor information would simply not be
output.

=
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Q. Why has the code information not been output?
Are you using thematical coding or free coding?

If you have coded with thematical coding then the code export

variables must be entered into the Fixpoint (TPS/GPS) Exportstring.

If you have entered the code export variables into the Code (TPS/
GPS) Exportstring, no thematical code information will be output.

The format files created in Quick Tours | and Il in this book can only
be used with thematical codes. Please refer to Quick Tour Il in this
book for further information on thematical and free coding.

If you have coded with free coding then the code export variables
must be entered into the Code (TPS/GPS) Exportstring. If you have
entered the code export variables into the Fixpoint (TPS/GPS)
Exportstring, no free code information will be output.

Additionally, when you export the surveyed data from the sensor or
SKI-Pro, the data must be sorted by Time. If the surveyed data is
sorted by Point Id, no free code information will be output.

The format file created in Quick Tour Il in this book can only be used
with free codes. Please refer to Quick Tour Il in this book or Chapter
8 of the System 500 Technical Reference Manual for further
information on thematical and free coding.
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Q. What is the String Pool?

The string pool is a library for storing "strings" (combinations of
export variables). This may be useful if you wish to use the same
combination of export variables again and again in different format
files.

Example: How to save strings into the string pool

You wish to use the combination of export variables shown below in
other format files you will create.

[ Format Manager - [Noname1]
[E) Fle View Fomet Opiions Window Help

SR ]

-4 Head «Point ID (Target)», :«Target (East)», -«<larget (Horth)»,-«larget (Elev)s

=4 Expor
pey

fon (GP5]
- Code (TP3/GPS)
- Date/Time Infor

»Right click in the edit view or tree view sections of the screen to
activate the String pool menu. Choose Save. Alternatively select the

2 icon from the toolbar.

: Format string pool - Export formatstiings

(- Selection fisr

>Enter a name to identify this Teroite:  [GPS500_Stendrc 7]
combination of export variables and Doltiock ppe: [Froort TFS/GREE
save the combination to the string ot

pool. e
>Click Save. —e

Stingsinpook 4

Stinglength: 41
No of vaiicbles: 4

Stingname: 1] oo
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the formatstring where you will load the string from the
You now wish to create a different format file that will use this String poo| will be deleted when you load the String_
combination of export variables.

Example: How to load strings from the string pool @ Any export variables or entered text that is present in

»Open the tree view to access the Fixpoint

[E Fle Wiew Fomat Options Window Help

Export Formatstring. EETNERE R
€ Header
4 Export Fomatstings
& Baseline Information (GPS)
Code [TPS/GPS)
G Date/Time Information (GFS)
& Event Infamation (GPS)
- Finpaint (TPS /GFS)
[ Exportstiing
G Jub (TPS/GPS)
Quality information (GFS)
- Satelite Infomation (GPS)

»Right click in the edit view or tree

view sections of the screen to

activate the String pool menu. .

Choose Load. Alternatively select the e [

i Format string pool - E xport formatstrings [7]x]

2| icon from the toolbar. Datablock ype: [ oo 10 <]

The pool content shows what s

strings are currently stored in the encre |

pool. T
Save

»>Select the correct string and click Sitioes 8

Load. Stiing lengih

Mo of variables:

Stting narie: d. coordd

Close

The combination of export variables
will appear in the edit-view.
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